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1. Introduction

We have completed the analysis of the soils and waterways for our map of the Navarro River Watershed and
conducted some basic visualization. But now we need to make the map!

In this lab exercise, you will take the map you worked on last time, and turn it into a complete, ready to print or
share PDF map. You will add all of the core components of complete maps, including a title, legend, north arrow
and scale bar. You will also list your name and the date the map was edited. Finally, you will add an inset map to
provide context about the location of the main map, and you will link that inset map to the main map.
Cartography can be a very involved process, but also incredibly rewarding as you see your analysis work become
a broadly-usable product!
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1.1 Insert a New Layout

So far in ArcGIS Pro, we have worked with Maps and Layers, as well as some of the properties of each (such as
symbology). Now it's time for us to add a third item to the project, a Layout. If Maps are for working with
geographic data in the application, Layouts are how we can create maps for print or export, sometimes called
"paper maps" even though these days they are often used as PDFs that may never be printed. Regardless, they
are how we take the display of geographic data on our screen and make it into something complete that can be
referenced as a map outside of the software.

To insert the layout
1. Switch to the Insert ribbon
2. Click New Layout
3. In the ANSI - Landscape section, choose the Letter 8.5" x 11" sheet. It's possible your screen could show these
options differently, so make sure you choose the landscape (wider than it is tall) 8.5" x 11" option, or at least a
landscape option.
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2. Everything changes!

Upon choosing a layout, immediately the application changes significantly in many places.
1. We see a new tab appears next to the Map tab that we previously used (but likely paid no attention to), called
Layout.
2. The Contents pane is now empty (where did everything go? We'll figure that out in a moment) - it also has
fewer display options at the top and the root element is now Layout instead of Map.
3. The Insert ribbon has changed significantly. Many of the available items for use on Maps are gone and
replaced by items specifically meant for Layouts.
4. We see a new ribbon tab for Layout, fully replacing the Map tab we saw before.
This is the context sensitivity of ArcGIS in action. When we're looking at layouts, ArcGIS only shows us tools that
are relevant for layouts. When we're looking at maps, ArcGIS only shows us tools that are relevant for maps.

At times, this can be frustrating for new users, because the path to find something doesn't seem like it's always
visible on your screen, though it is. But it has quite a few benefits - if we can't find a tool we think we're looking
for, it typically means we're not looking at the right thing right now. If I want to make a modification to my map,
but don't see the Map tools that I'm expecting, it means I need to change my context. Once you get used to it, it's
very powerful and also prevents you from trying to use tools that aren't applicable.
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2.1 From a blank page to a map

Right now, we have a blank page in the size we specified, but nothing more, so let's change that by making our
page show the data we've worked hard on.

To do that, we'll add a Map Frame to the page, which allows us to select one of the maps in this project and
display it here. It will be linked to the map, so when we make changes to the map they will show both back in our
Map view and on this layout.

To add the Map Frame, we'll use one of the new tools on the ribbon.
1. Click the Map Frame button
2. In the options that appear, click the one that has a set of numbers (a scale) and a preview of the map. ArcGIS
Pro tries to give us multiple options for how to add the same map to our document - right now we only have one
map, but two options for how to place it - these are mostly equivalent and aren't permanent choices (we can
easily change one to behave like the other later), so it's OK to just choose one. For now though, the Default Extent
option will show the whole world due to our basemap, while the one that shows 1:324,244 will be zoomed to
show the data we've added, so we'll choose that one.
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2.2 Making the Map Frame

After clicking the option for the map frame, nothing happened. Why?

Well, we need to now draw the map frame on the page to indicate the size we want it to be (note the way your
cursor changed). To draw the map frame, click and drag your mouse (click, holding the left mouse button down)
from the top left of the layout toward the bottom right, leaving about an inch of space in the bottom, but taking
the full width. Note the rulers on the left and top for measuring distances on the page here - it's OK if yours isn't
exactly the same - close is fine, and we might adjust this later anyway.
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2.3 Looking more like a map now

Now our map shows on the page. Progress! Once again, note what has changed in the interface:
1. The most immediate change is that our map now appears on the page, looking similar to when we last saw it,
but with some text in the bottom of the frame.
2. Under the Layout element in the Contents pane, we now have a Map Frame and then within that we see our
map and then all the layers exactly as they were when we were looking at the Map tab. Note the checkbox next
to Map Frame that lets us turn the item on and off on the layout, just as items within the map itself can be turned
on and off.
3. Note the Map Frame Format ribbon tab that appears. We'll see sections of ribbon tabs appear more in the
future.
4. Compare the items in the blue box with everything you see when you switch back to the main Map tab. Are
they the same?
5. Switch back to the Layout tab.
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3. Let's name things more clearly

You may have noticed things were starting to get confusing - we had the concepts of layouts, layout tabs, and a
layout with the not-helpful name "Layout" - same for maps too.

1. Expand the Catalog pane from the righthand side (if it's not there anymore or you accidentally closed it at any
point, it's on the View ribbon as a button named Catalog Pane).
2. Another context-sensitive item! We have a Layouts section in the Project tab of the Catalog. This one is
slightly different in that it's not sensitive to what we're looking at, but just what's in the project. Until now, we
didn't have any layouts in the project, so the Layouts section didn't show. Since we now have a layout, we see the
section.
3. Click the layout named Layout that will be in that section. You can either hit the F2 key on your keyboard, or
right click on it and then click Rename to start renaming it. Name it Landscape Print Layout and then hit the Enter
key on your keyboard to make the change
4. 
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3.1 While we're at it...

While we're naming things, let also change the name of our map.
1. Expand the Maps section in the Catalog pane
2. Rename the map named Map in that section to Navarro Watershed Map
Hit Enter on your keyboard again to make the change
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3.2 Note everywhere it changes!

Immediately, this change takes place throughout the application anywhere that used that map - it shows in the
Catalog pane, in the tabs at the top of the mane view, and even in our Contents pane within the map frame. That
should help make things clearer as to which map we're looking at in the future (and make it easier for us to
specify instructions).
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3.3 Rename the Map Frame too

One more thing to rename - this time, the map frame. It will be useful in just a moment, while also being clearer
as we add more items to our layout.

1. Click on the Map Frame in the Contents pane and use the F2 key on your keyboard to start renaming it. Then
type the name Soil Drainage in the Navarro River Watershed. Use the Enter key again to make the change.
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4. Inserting a title

Now, let's add a title to our map. Looking at this now, it's not clear what we're looking at to anyone who didn't
make the map. We'll use Dynamic Text for this. Dynamic Text is helpful because it lets us avoid entering things in
multiple places, so that if things change or we get feedback, like on the title of our map, we only need to update
one place to have it changed everywhere in the project. It makes maintaining a project like this much easier.

1. Make sure you're in the Insert ribbon, then click Dynamic Text
2. You'll see an option called Name with a preview underneath it that has the same text as the name of our map
frame. Click that option.
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4.1 Make a box

Just as with the map frame, click and drag to outline the area where the text will go. In this case, put it in the
blank space just below the map and make it relatively large (like a title on a page would be).
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4.2 Small text!

Despite the size of the box we drew, the text is small - it did use the name of our map frame, but it doesn't seem
to behave automatically as if it's a title. Let's fix that.

Notice that now that we have a text element selected on our layout, ArcGIS Pro automatically adds a ribbon for
text formatting and activates it for us. We can switch to other ribbons and back if we want, but this ribbon only
shows when a text element is selected on the layout.

On this ribbon is a Text Symbol section, which includes the ability to specify basic properties of text that you'd be
familiar with from other applications - font, size, color, justification, etc. But it also comes with premade styles we
can use in the lefthand box with the Text Symbol section. Let's use one of those.

Click the little down arrow in the bottom right of that box - it indicates that we want to expand it and see
additional options since it only has space to show us two right now.
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4.3 Apply title formatting

1. Now scroll way down and you'll see a section named Layout with an item named Title. In fact, many options
appear to start with the name Title and you can hover your mouse over each one to see their full names. Click on
the first option.
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4.4 Fixing the title

Our text is updated to a bigger size more appropriate for a title now, great! You could also continue customizing
it with the Text Symbol options if you want to.

Now that it's big though, I'm wondering if there's any way to get rid of the "Name:" that starts off this dynamic
text - it's distracting and unnecessary for us.

1. To explore our options, we'll right click on the text element with the title in it and choose Properties. Many
items in ArcGIS have properties panes or popup dialogs that will show if you attempt the same process on them
- we haven't shown much of it yet, but it's another core piece of the ArcGIS interface and its workflows.
2. A new Format Text pane flies out with additional options for us that aren't on the ribbon at the top. Importantly,
on its first tab, in a section named Text we see "Name: name", with the second "name" in a box. This second item
represents the dynamic text that pulls the name of our map frame and places it on the page. But the first part is
optional and we can remove it. Place your cursor in the box and delete the text that says "Name:". If you
accidentally delete the dynamic text too, use the undo arrow at the top left of the application to revert the
deletion. Note that this means you can also put any text you want here, and can even remove the dynamic text
and add any title you like directly in this box.
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4.5 Updated dynamic text

Great, now our title looks appropriate, and comes from the name of the map frame! One last thing on this title
now - instead of centering it in the text box, let's left align it. Click the Left Font Alignment icon in the Text Symbol
section of the ribbon.

Introduction to ArcGIS Pro Lab 3: Laying Out Maps - Copyright Nick Santos and UC Davis Continuing and Professional
Education 2021

Page 17



  Introduction to ArcGIS Pro Lab 3: Laying Out Maps

5. Addition Map Elements: North Arrows

Next, we'll add a North Arrow to a map. North arrows help orient the viewer of a map to the rest of the world by
showing them where north is located on the map. While they are becoming less necessary on maps where north
is at the top since viewers are accustomed to this convention, it's still good practice to include one.
1. On the Insert ribbon
2. Click the North Arrow button
3. Select any north arrow you like. I chose ArcGIS North 2.

Not shown here is that once you click on it, you'll again need to click and drag to add the north arrow to your map
in the size you want. I placed mine in the top right corner.

5.1 Moving it around
If we click on the north arrow after placing it, we can resize it in any direction using the handles, and if we hover
the mouse over it now, we get a cursor icon telling us that we can move it by clicking and dragging it.
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5.2 Format North Arrow

Even more context sensitivity! The pane on the righthand side that we had open for formatting text changed to
Format North Arrow. We can now see north arrow specific properties that we can change (and there are more -
check for new tabs on the ribbon!). Try switching back and forth between the title text and the north arrow and
see the pane change contexts.
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6. Contents filling up

Now that we have a few more items on our map, our Contents pane is starting to look different from how the
Navarro Watershed Map's Contents pane. We have an item for a north arrow and an item named "Text" for our
title. Let's make it clearer that this text element is our title.
1. Click on the item named "Text" in the Contents, hit the F2 key on your keyboard to start renaming it, and give it
a better name, such as "Map Title Text" - that way you'll know looking at your contents which item it refers to.
Why might we want to do that? Because these items in the layout are layered too (some draw "above" others on
the page and can cover them up if they're in the same spot), just like the items on the map. Try turning items on
and off or rearranging the order of them (click and drag in contents to move them) to see what changes on your
map.
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7. Next Up: Scale Bar

Now, add a scale bar - scale bars tell us how much distance in the real world is represented by each unit of
distance on the page, such as 2 centimeters being equivalent to a kilometer on the ground. The process to add
the scale bar is exactly the same as with the north arrow - find the one you want and draw it on the page. See if
you can do it now without looking at the picture or the rest of the text on this step:

1. On the Insert tab, click the Scale Bar button
2. Choose a scale bar - I chose Alternating Scale Bar 1
3. Click and drag the box on the page the same way as you did for the other page elements.
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7.1 Adjust the scale bar

Once you have the scale bar on the page, again note the context changes (marked in the image), such as the
properties pane switching to become Format Scale Bar. Again, if you've closed that pane, you can open it up for
any element by right clicking on it and clicking Properties.

Now, let's change the scale bar we added to kilometers and adjust thh size a bit.
1. In the Format Scale Bar pane, click the Map Units dropdown and change it to Kilometers
2. Make sure the scale bar uses whole numbers without decimals. Hover your mouse over the left or right dot
around the edges of the scale bar box until you see the double arrow mouse icon and drag it left or right and
release. Repeat until your scale bar has mostly whole numbers
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8. Add text for your name, data sources, and the date

Now, add some free-form text to the map - every map should include the map author's name, the data sources
used, and the date it was produced. We can add your name with a freeform text element and then we can add
more dynamic text for the date.
1. Click the Rectangle Text option in the Graphics and Text section of the Insert tab. You can hover your mouse
over the icons to see their names.
2. Do the familiar click and drag to make the rectangle for the text. Then put the text "Author: Your Name" in the
box (replacing "Your Name" with your actual name). Also include "Data Sources: Rivers - NHDPlus Version 2,
Soils - SSURGO"
For the date, you'll handle that on your own - take a look at the dynamic text options for dates - I recommend
"Current Time" or "Date Saved" as good options. Feel free to add any other dynamic text you think is appropriate.

(The eagle-eyed among you will notice that I forgot to add the date in the screenshot for this step. It'll show up
later in the tutorial - rather than create confusion, I'll just acknowledge it here - it's coming, but I forgot it! Go
ahead and add your date now)
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9. Got lost? Zoom to Page!

As a bit of housekeeping, if you've zoomed your page out and in at all and want a reset, like we can do on the
map, you can right click on the layout itself in the Contents page and choose Zoom to Page.

Also, have you saved recently?
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10. Making adjustments to our map

I said earlier that the map and the layout were synchronized. One way they're independent is in their scale and
extent. If we were to switch back to the map itself and change our zoom and look around, out layout would be
unaffected. This is useful since we can go back and do further analysis and our map's main features won't be
affected (though if we add/remove items or change symbology, those will show on the layout).

This map is zoomed out a bit far from the watershed. Let's adjust the scale of the map - to do this, we need to
"activate" the map on the layout. Activation puts us into a mode where we're editing the map, almost the same
way as if we were on the map tab, but we're adjusting the parameters of the map frame while having access to
properties of the map. As before, the context sensitive tools will be our guides in what we can do. To get started,
Make sure your map frame is selected (it'll have the dots around the border). Then:
1. Right click on the map frame and choose Activate - it is also on the Layout ribbon.

Introduction to ArcGIS Pro Lab 3: Laying Out Maps - Copyright Nick Santos and UC Davis Continuing and Professional
Education 2021

Page 26



  Introduction to ArcGIS Pro Lab 3: Laying Out Maps

10.1 We're through the looking glass now

This moment is a bit weird, but powerful. Right now, our view is both a map and a layout view! I always think this
feels sort of like Alice stepping through the looking glass or Frodo putting on the ring of power (hopefully at least
one of those references makes sense!). They're in almost the same world they were before, but everything is
both different and the same.

I'll note that this process of activating a map frame to make adjustments and deactivating it is what I've
observed as the most commonly frustrating experience for new users of ArcGIS Pro, because it requires
remembering a process that isn't used anywhere else. I note this not to color your perception of it, but hopefully
to heighten your recollection of these steps so you remember it in the future. It's not complicated, but you'll need
to remember how to activate and deactivate map frames.

1. More concretely, the first thing you might notice is that all the elements of the layout that *aren't* the map
frame are grayed out. We can't click on them or interact with them in any way. They're temporarily unavailable
(more on getting them back in a moment)
2. The Contents pane is back to looking exactly like it does when we're editing the map
3. And the Map tab is back and activated on the ribbon! These two items make it seem like we're working on the
map again (in fact, we are!)
4. There's a new context sensitive tab on the ribbon for our activated map frame (that's one place you can
deactivate this to return to the layout)
5. And even though we're editing the map, the Layout tab is still active in the main view, because we are still, in
fact, editing inside the layout. If we want, we can also deactivate the map frame by clicking the little arrow in the
header bar that came up below the tab, or by clicking the red X button on the right side.
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10.2 Adjust the extent

Now, let's make the change we activated the map frame for, adjusting the extent.
1. Activate the Rectangle Zoom In tool on the Quick Access Toolbar.
2. Click and drag a box within the map frame to zoom in a bit closer to our data
The map's extent will update. You'll notice later that the scale bar will update after this automatically, which is
great - it should always show the correct extent - but we'll now have more decimals. We'll fix that a little later
when we're done making these types of modifications.
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11. While we're here - update the symbology

So now, while we're here with the map activated, let's make some improvements to the map's symbology. Right
now, it's a bit of a jumble. We can display the map a bit better than this without too much trouble!
1. Turn off the navarro_streams_100m and navarro_streams_100m_Spatial layers. The buffer and spatial join
layers might be useful analysis products for our project, but aren't very helpful on a map of this scale
2. Activate the symbology pane on the navarro_streams layer (either click it and open the symbology pane on the
right, or right click it and choose Symbology from the menu).
3. I personally feel like rivers layers with a single size for all rivers feel like a missed opportunity. These rivers and
streams aren't all the same size, so a map of the rivers should display them at different sizes. Luckily, we already
attached data to our streams layer with the stream size. All of this data - the rivers and the joined data come
from NHDPlus Version 2 if you wanted to replicate this elsewhere. In the Symbology pane, open the dropdown
that currently shows Single Symbol
4. Switch to Graduated Symbols which lets us set different sizes for features based on their attributes.
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11.1 Choose the field to symbolize on

Now the symbology pane will change to give us the options for this type of symbology. The primary option we
need to change is the Field. For this parameter, what happens is:

ArcGIS looks into the attribute table of the feature class and determines all of the unique values in the
field/column we select here

It then splits those values into ranges based on their numeric values (there are many ways of doing this,
which can dramatically alter interpretation of the map - we'll talk about that elsewhere though)

It assigns separate symbology to features whose value for the selected field falls into each range of values.
In this case, it'll change the size of each range's (called a Class here) symbols, but we could have selected
Graduated Colors instead and it would change the color for each, which makes a common type of map called a
choropleth.

ArcGIS chose the COMID field by default, but in this case, we'll use the field with the drainage area of each
segment as a proxy for its size. This might be a bad choice in fields with braids and branches, in which case you
might want to use DivDASqKM instead since it represents the Divergence-routed upstream catchment area, so
braids have area approximately related to the amount of flow that goes through them.
1. In this case TotDASqKM is fine, so we'll use that. Choose it from the Field dropdown
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11.2 Updating the template

Now ArcGIS updates the classes in the bottom box, but the color of the symbol makes it hard to see. Let's
change the Template - the base symbology it uses for all classes, then modifies the sizing for each one.
1. Click on the symbol next to Template
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11.3 Change the color back

Now we'll repeat something we did earlier: changing the color to Yogo Blue (or any other blue you like).

1. Switch the symbology pane to the Properties tab.
2. Choose a new color from the dropdown. Yogo Blue is the third from the right on the second row (you can
hover over patches to see the name).
3. Click Apply to update the symbology.
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11.4 Now update the soils colors

Great, the rivers are updated and their sizing looks good, but I have a new problem. In my case, Yogo Blue was
also used for one of the soil groups. Let's change the soils colors so we can see everything:
1. Leave the symbology pane open, but switch to the soils_navarro layer in the Contents pane so that the
Symbology pane now applies to it.
2. (Not shown on the picture) You'll see a set of patches to choose from for colors for each soil drainage class.
Click the colored box for any that are hard to see on the map or that make the rivers hard to see
3. Switch to the properties tab
4. Choose a new color
5. Apply the color change
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11.5 Now we can see the rivers!

With the new color on the soil drainage class, we can see the rivers and the soils now. Let's make one more
update to the soils appearance while we have it selected. We'll make it semi-transparent so that some of the
hillshade in the basemap shows.

1. Switch to the Appearance tab in the Feature Layer section
2. Adjust the value for Transparency in the Effects section by typing in 20% or using the slider until it's
approximately 20%. Just enough to see the hillshade effect a little bit, but where the colors in the soils layer are
still clear.
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11.6 Back through the looking glass.

Make any other changes you want to the symbology. For example, my version is very blue right now - it'd be
clearer if I differentiated the soils colors and the rivers better - see if you can improve yours! Your map need not
look the same as this as the tutorial is a demonstration of capabilities. Make it look as good as you can.

When you're ready, let's head back through the looking glass and deactivate the map frame.
1. Switch to the Layout ribbon tab in the Activated Map Frame section
2. Choose Close Activation to switch back to editing the layout.
As a reminder - many of the changes we made to the map in this mode could also have been made by just
updated the map on the Navarro Watershed Map tab we have open in the main view. The only one we must do
through the activated map frame is the extent adjustment we want for the layout. Extent adjustments in normal
map mode only apply to the view of the map itself, not to map frames.
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12. Adding the Legend

Now comes the big item, the legend! Legends help viewers to understand the information on the map by defining
symbols - it shows symbols that are on the map and then provides the layer name or other details to indicate to
the viewer what they are looking at.

To add a legend, we'll follow our now-familliar process:
1. Click the Legend button in the Map Surrounds section of the Insert ribbon
2. Click and drag at the spot on the layout where you wa
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12.1 Choosing items in the legend

A legend with lots of information shows up and now we begin the process of cleaning up the legend and making
it less confusing.

To start, the legend gives us a checkbox for the visibility of each layer. By default, it's a secondary checkbox -
even if the layer is checked in the legend, it won't show if the layer isn't also checked in the map contents pane.
But, it can still allow us to turn off layers that are shown on the map (sometimes we don't need to show obvious
items in the legend - for example, I wouldn't leave a legend item for rivers if they were just simplified lines).

1. Expand the legend in the contents pane (the little triangle next to it) and uncheck the boxes for the buffered
streams layers. This way, if we choose to turn them back on at any point, they won't show up in the legend still.
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13. Legend Properties and Styling

Now let's bring up the legend properties so we can do some styling. At the moment, it's not very readable with
small text hovering over the water and with so many layers and extra text. We can make this look a bit more
professional without doing anything too fancy.

1. Right click on Legend in the Contents pane and choose Properties. If your Element pane is already up, then
these properties will have already been showing.
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13.1 Styling the legend

To start, we'll style the background so that we can see the text a bit better.

This is where ArcGIS starts to have *many* hidden menus and an interface that can become intuitive elsewhere
stops being intuitive, which is unfortunate. I think ArcGIS Pro did a good job of rethinking the user interface of
old versions of ArcGIS and making a unifying set of concepts that, once you got used to them, make the
software fast and easy to use. You'll notice that the Format Legend/Element pane has three separate types of
menus, each with their own expandable subitems. It has the text-based tabs at the top, the icon-based tabs
below it, and then the dropdown tabs for the text-based tabs at the top. I've been using ArcGIS Pro since it was in
beta and I still haven't figured out the rhyme or reason for what goes where in these menus even when the rest of
the software makes sense. Plan to look through all of these for items when you want to do formatting and note
that some of them are in multiple places - we'll see that in a moment.

1. For now, to change the background of the legend, click the triangle for the dropdown next to the Legend tab at
the top of the pane,
2. Then click the Background option.
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13.2 Add a legend background

This pane will be familiar - it's similar to symbology selection (back to some consistency, at least!)
1. Click the color selection box
2. Choose the white patch in the top left.
3. Click Apply to make the change
4. Click the back arrow in the top left of the pane to return to the main Legend properties pane.
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13.3 Add a legend border

Now let's add a border to give the legend some definition from the map behind it. Border properties are on the
third icon tab (hover text Display) - and in fact, you can see the background properties here too, though we get
less detail than in the location we changed it.

1. Change to the Display tab
2. Click the icon patch for the Border symbol (expand the Border section if necessary)
3. Choose Black in the bottom left of the patches.
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13.4 Add some padding

Getting better, but text all the way to the edge of a box rarely looks good - let's add some padding, which is space
between the border and the content of the box. On the same tab as we were on before, we'll now adjust the
"gaps":
1. Change the X gap and Y gap in the Border section to 0.1 inches
2. Change the X gap and Y gap in the Background section to 0.1 inches as well.
If you forget to do both of these and only set one, the box can end up looking a little silly (such as with the border
floating away from the background of the box), but it can be nice to have this amount of configurability.

(It's another good time for a reminder to save your work!)
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14. Changing the names of items

Now let's fix those names in the legend. While navarro_streams might be interpretable to someone, it's not
particularly useful, and drclasswet is not helpful at all. We should give these layers more descriptive names. One
way to do this would be to rename the layers in our Contents pane - the Legend would update with the new layer
names and we get the benefit of our document being more descriptive. I personally like my layers, in most cases,
to indicate the name of the actual dataset, though I think that's becoming increasingly old-school and less
useful. But following that, let's change what's displayed another, similar way by adjusting the text ArcGIS places
for us that describes the field it's using to symbolize layers. This ends up being a multi-step process to get right -
we'll need to change the text in one place, then change what the legend chooses to display in another.

1. To change the text, we use the Contents pane. Just below navarro_streams you'll see TotDASqKm since it's the
field being used to create the symbol classes. Click on that text and hit your F2 key to rename it. Make the name
something like "Total Drainage Area (Sq Km)" and then hit Enter on your keyboard to make the change.
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14.1 Turn off the layer name

Now that we have useful text attached to the layer somewhere, let's go make sure ArcGIS Pro uses it in the
legend.

1. Find the Legend in the Contents pane and expand its items (if not already expanded). Click on
navarro_streams within those items and either click the Element pane open on the right side, or right click on
navarro_streams instead and choose Properties to bring the Element pane up.
2. By default, we'll see the options for display of this item that we need. The very top has a section called Show
for enabling or disabling parts of the layer. Try turning each of them on and off to see what happens. When
you're done make sure Layer name is unchecked and Headings (the item we changed to have descriptive text)
and Label are checked.
Now our streams legend makes more sense!
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14.2 Next up, soil drainage

Now we'll follow the same process for the soil drainage.

1. This time, rename the drclasswet label "Soil Drainage Class (Wet)". Note that this renaming doesn't change
anything in the attribute table or how the symbology matches to fields - just how it displays that. Make sure that
you perform the rename on the soils_navarro layer, and not on the buffered streams with the spatial join.
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14.3 Turn off the layer name

And once again, turn off the Layer Name in the legend for the layer
1. Select soils_navarro in the Legend section of the Contents pane
2. Use the Element pane to turn off the Layer name in the Show section.
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15. Legend Updates: Cleaning up multi-item legends

OK, this legend is vastly improved, but I see a few more obvious issues:
There's a weird gap between the Soil Drainage Class heading and the categories
We don't need to display <all other values> for Soil Drainage Class (we don't have any)
The spacing between items isn't good - navarro_boundary ends up looking like it's part of soil drainage class
There are too many decimal places on the streams data.

So, let's work on each of these, starting with the gap between the drainage class heading and the items below it.
This is being caused by a semi-unique situation with the data (there will always be these types of problems
though!) where I happed to set features with no drainage class specified to use the color white, so that spot is
showing a white square, on a white background, with no text.

1. Bring up the Symbology pane for the soils_navarro layer.

This is also the same thing we would do if we wanted to reduce the number of decimal places in the rivers layer's
drainage area - edit the Label field in the symbology. I won't do that here in the tutorial, but encourage you to.
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15.1 Turn off All Other Values

Now let's get rid of that All other values patch too.
1. Make sure you're editing symbology for soils_navarro
2. In the Classes tab, in the top right, there's a More menu. Click on it
3. Click Show all other values to uncheck it and disable it. You'll see the all other values patch disappear from the
Classes box and the legend.
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15.2 A few more legend fixes

OK, on to a few more fixes. First a simple one.

1. Rename the navarro_boundary layer to Watershed Boundary
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15.3 Change the spacing between items

Now let's change the spacing between items in the legend so that each one is separated nicely. A decent rule of
thumb for headers is that they should be about one full line of text away from the item that preceded them, so
let's make a change that looks like that.

1. Bring up the Element pane for the Legend
2. Switch to the second icon tab (Legend Arrangement Options)
3. Expand the Spacing section if needed and change the spacing value for Items to 20pt.
You'll see the spacing between items in the legend update. Feel free to adjust any other values you like to
improve the legend display.
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15.4 Resize the legend

Now, we're done modifying the legend. As a matter of housekeeping, I recommend resizing it to match its
approximate size better - the boundary box for mine, when selected, was now different than the actual size of the
legend. It won't affect the legend's display (it will take all the space it needs), but will help other items to correctly
snap to the legend's position as you move them around.
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16. Clean up the layout a bit

Now, let's clean up the layout a bit. I decided that for this map I wanted to move the scale bar and north arrow to
the bottom bar since there was going to be a lot of blank space there otherwise and moving them there keeps
more parts of the map visible. Adjust your layout as you see fit!
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16.1 Service Layer Credits

One item for cleanup when using Basemaps is the Service Layer Credits - It's text that automatically draws on top
of the basemap that shows where basemap data came from. We need to show it, but it's often in an inconvenient
place that draws on top of our data. And there seems to be no way to delete or move it - at least, you can't click
on it and get a box to move.

It turns out you can relocate it, but you'll need to use Dynamic Text again.
1. Switch to the Insert tab
2. Click Dynamic Text
3. Find Service Layer Credits in the set of options and click on it.
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16.2 Choose a new spot for them

1. As with other items, click and dag in a new place to create the text box - I put mine below my Data Sources
text.
2. Then bring up the Element pane for this item (right click on it and choose Properties if you can't find it). Edit
the text before the dynamic text to say "Basemap Credits:"
Now the service layer credits have been removed from the map frame and are in a more appropriate place.
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17. Adding the inset map

This map is really starting to shape up, but one important item is still missing: an inset map that shows people
context who may not be familiar with what area they're looking at. For now, we'll assume the people who will
view this map inside and outside our organization generally know California, but might need some context on
where in California this watershed is.
1. To add an inset map, the first thing we need is a new map! It can be done with this map too, but that's an
advanced technique and a bit beyond the scope of this tutorial. To get started, switch to the Insert ribbon and
click New Map
2. If you clicked the dropdown arrow, make sure to choose the normal New Map option.
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17.1 Change the basemap

A brand new map shows up as a tab in the main pane and in catalog. Once again, the application switches
contexts for us since we're now editing a map and not a layout. Note that in the Catalog pane, we have another
map in the maps section too (I have one more than you will have because I saved a copy of my main map at one
point)

The only thing we'll do to this map is switch the basemap. We'll have the basemap provide our context. Some are
better at this use than others, and much of it will be personal preference. For now, we'll use the Light Gray Canvas
basemap since it's very general and fades to the background nicely.

1. On the Map ribbon, click the Basemap button
2. Then click Light Gray Canvas
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17.2 Rename the Inset Map

Now, for some housekeeping rename the inset map.
1. Click on Map in the Contents pane and rename it "Inset" (that shortcut key is F2, as a reminder)

Introduction to ArcGIS Pro Lab 3: Laying Out Maps - Copyright Nick Santos and UC Davis Continuing and Professional
Education 2021

Page 57



  Introduction to ArcGIS Pro Lab 3: Laying Out Maps

18. Back to our layout

Now, let's go back to our layout again
1. Switch tabs in the main pane to Landscape Print Layout
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19. Add a second map frame

Now, we want to make that map show up on our layout too. We'll add a second map frame for this.
1. On the Insert ribbon, click Map Frame
2. Under the Inset header, choose the one that has a scale below it and a preview again.
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19.1 Draw the map frame

Draw the map frame again - I put mine in the upper right corner
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19.2 Adjust the Inset

Now, let's adjust the new map frame to show the area our current map is in. To do so, we'll need to activate it
(back through the looking glass everyone!)
1. Right click on the inset map and click Activate
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19.3 Use the Explore Tool to Move it

Now, we need to set the map extent to something that shows the same area as our main map, but also a lot of
area around it. This watershed is a few hours north of San Francisco, so we'll want to make sure that we can at
least see the label for San Francisco on the basemap, and possible more.

To adjust the map's zoom and extent:
1. Activate the Explore tool
2. Click and drag in the inset frame to move it around - scroll in or out to zoom as you like
3. (Not shown) - Deactivate the map frame (Layout tab on the ribbon)
I ended up showing most of the state, with San Francisco in the middle of the frame and even Los Angeles
showing at the bottom. I zoomed out about one step and panned northwest of where my map was by default
(see next step for how mine looks). If we wanted to make this more precise, we could have added the watershed
boundary to this inset map too and then zoomed to it to get the location, then zoomed out. For now, this is fine.
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19.4 Add the extent indicators

That map is fine now, but it's not yet useful at indicating where the main map is located. To do that, we'll need to
add Extent Indicators. These are some kind of outline (typically) that shows on the inset map that shows where
the data in the main map is.

Now, I always forget how to do this in ArcGIS Pro and have to look it up! I usually think it should be in the element
properties of the map frame, but it's not. It's an item we Insert.
1. Select the Map Frame that has the map named Inset in the Contents pane (don't select the inset map itself).
This is the map we want to add the extent indicators to/
2. On the Insert ribbon, click the button named Extent Indicator in the Map Frames section
3. Choose the only other map frame listed there named "Soil Drainage in the Navarro River Watershed" - we want
to add an indicator of the extent of this map frame to the inset map.
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19.5 Adjust the extent indicator to make it more visible

1. Now, we'll see a new item within the map frame in the Contents pane called Extent Indicators with a subitem
named "Extent of Soil Drainage in the Navarro River Watershed" - click on that an bring up the Element pane in
order to style it.
2. Change the outline color to red
3. Then change the width to 2pt.

It's possible that after seeing where the extent indicator is, you might want to adjust the map extent again, in
which case you'll need to activate the map and use the explore tool. That's up to you - I'll leave mine as it is.
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20. Clean up and export

Now we have a complete map - do some quick checks and cleanup - make sure that your scale bar still looks
good after extent adjustments and you like how everything is positioned, etc. Once you've done that, we're ready
to export our map to share. Before we do, save your map one more time.

1. Click on the tab for the Share ribbon
2. Then click the button named Layout in the Export section.
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21. Set export settings

The Export Layout pane will come up. There are lots of options, so it's important to look around:

1. Select the file type to export under the Save as type options. We'll use a PNG in the demonstration since
they're images that are viewable without special software, but you could also use a PDF since exporting a PDF
file allows us to share with a broad audience. We choose this first because our choice of file type determines
what options are available.
2. Choose the path and name you want to use for export
3. We want the output map to be high quality and ready to print. While the default resolution of 96 dpi (dots per
inch) is fine for displaying on a screen, printers need higher resolution files. Change the Resolution setting to 300
dpi by typing 300 in the box.
4. Click the Export button to initiate the export of your map.
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22. Export complete!

When it's done, you'll see a green box that says "Export Completed" - click the link to view the exported file to
open it up and inspect it!

This exercise is now complete. Though other tutorials will still take place in this region, we won't continue from
here. It's still a good idea to save your work in case you want to return to this point.

In this series of three tutorials, we looked at how to use ArcGIS for data exploration by adding data, querying it,
and creating selections. We subset a larger dataset, changed styling, and did some geoprocessing to buffer and
attach new information to data via tabular and spatial joins. Finally, we made a map and learned just how
context sensitive ArcGIS Pro is, utilizing the many tools for putting together a quality print map.
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23. Bonus Exercise: Labeling

There's one more thing we left off here that you might be interested in trying out for a print map: Labeling.
Labeling tools let us have ArcGIS place text on the map for features based on information in the attribute table.

If you want something to try independently that tests skills you learned here, try to enable labeling for the rivers
layer. Here are a few hints about it:
1. You can turn on labeling for a layer in its right click menu.
2. Labeling is another context sensitive option - when it's selected, there's a labeling tab (and an associated
labeling properties pane).
3. You'll want to use the GNIS_NAME field for your rivers labels - ArcGIS will probably detect it by default (it
automatically uses fields that have "Name" somewhere in their name, if such a field exists
4. Labeling is a *deep* concept that is easy to start, but requires lots of time to learn and finesse. Play with the
options to see if you can improve the default labeling style a bit.
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